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SUPPORT: 

If you have any queries regarding the use of the ImmerGo system, contact Support at: 

support@immersivedsp.com 
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1 WELCOME TO IMMERGO! 
 
This manual will describe how to configure and use the ImmerGo-Install system. Before engaging with this topic, 
it is useful to have a broad understanding of the operation of the ImmerGo system. We shall look first at the 
components of an ImmerGo-Install system, and then provide a conceptual understanding of how they interact 
with each other. With these concepts in place your task of configuration and immersive sound creation will be a 
lot easier. 

1.1 IMMERGO-INSTALL SYSTEM COMPONENTS: 
 
Given below is a diagram of the hardware components of an example ImmerGo-Install system: 
 

 
 
ImmerGo is a client-server system, where the server can be a Windows or macOS laptop or desktop, and the 
client can either run on the server machine or a remote device that communicates wirelessly. The remote device 
can be a mobile device such as a tablet or smart phone (Android or iOS), or a further laptop/desktop. The client 
can be run by typing in a URL into a browser, or running an app from Playstore (Android) or the App Store of an 
iOS device. 
 
Note: the connection from the server to the switch should be a Thunderbolt to Ethernet connector. If you have a 
machine that only has USB-C plugs, then you will need two connectors – USB-C to Thunderbolt, Thunderbolt to 
Ethernet. There will be an Ethernet cable connecting each SPK-4P (active speaker) to a switch port. Power, audio 
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and control messages will be transmitted on the cable from switch to SPK-4P. Each SPK-4P has a small connector 
block attached to the ‘Amp’ socket. A cable should be connected from this connector block to the input of an 
SPK-4 (passive speaker), if you want this additional speaker capability. Note: - by itself an SPK-4P will deliver a 
maximum of 30 watts. When an SPK-4 is attached, the SPK-4P and SPK-4 will each deliver a maximum of 15 
watts. An NDAC-2 network connector can be used for Bass speaker connection.  
 
As a user, you will be controlling the localization of sound sources from the desktop or from a mobile device 
such as a tablet or smart phone. Multiple users can control the localization of multiple sound sources at the 
same time. The sound sources are typically wav files associated with audio tracks in a Digital Audio Workstation 
(DAW) or multichannel wav files that can be loaded. The DAW will be installed on the server machine, typically a 
Mac Mini or MacBook. Also on the server will be the ImmerGoServer software, which you will need to install. 

1.2 HOW DO THE COMPONENTS INTERACT? 
 
An ImmerGo user with a mobile device can do the following: 

1. Choose to select sound sources from a DAW or multichannel wav file 
2. Select audio channels and control their localization 
3. Control the transport of a DAW 
4. Record and playback localization moves 
5. Schedule wav files to be played in sequence with their localizations  

 
When a user controls localization of sound sources, the 3D sound source positions get sent over a wireless 
network to the server. Using these 3D sound source positions, and the positions of the speakers, the server 
determines what control values to send over the Ethernet AVB network to the SPK-4P speakers. 

 
When a user controls the transport of the server-based DAW, transport control commands are sent over a 
wireless network to the server. The server then sends MIDI commands to the DAW to control its transport. MIDI 
timecode messages are sent from the DAW to the server for the time stamping of localization changes. They are 
also sent to the client for display. 
 

 
When a user chooses a wav file to be the source of sound, then time code messages are generated internally on 
the server. 

Mobile 
 Client Server Ethernet 

AVB 

3D coords 
Control 
 values 
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2 PREPARATION BEFORE INSTALLING SERVER  
 

Your OSX server will be communicating with an Ethernet AVB network, which is a wired network. It will also be 
communicating with one or more mobile devices over a wireless network. You should ensure that there is just 
one wired Ethernet connection, and that it is connected to the Ethernet AVB switch of your Ethernet AVB 
network. You should also ensure that your Mac plays sounds to your Ethernet AVB interface by default. 

2.1 NETWORK SYSTEM PREFERENCES 
 

Go to the ‘Network’ system preferences on your computer, select the Ethernet network, and set the field 
‘Configure IPv4:’ to ‘DHCP’. 

See the example below. 
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Note – if you are using a Luminex switch in your configuration, please refer to Appendix 1. In the case of all 
switches, ensure that you have the latest firmware version. 

2.2 SOUND DEVICE PREFERENCES 
 

Go to the ‘Sound’ system preferences on your computer and ensure that the ThunderBolt Ethernet is chosen as 
the device for sound output. 

Given below is an example of such a selection. 
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3 INSTALLATION OF THE SERVER 

 
Ensure that you power up your switch(es), and that the LED at the back of each SPK-4P is alternately switching 
between red and blue.   Also check the LEDs on your switch(es) to ensure transmission is active.  
 
You should have downloaded an installation package file ImmerGo.pkg. Double click on the file and you will be 
guided through the steps necessary to install the software. The ImmerGo-install application should now be 
present in your Applications folder.  
 
Run the application. A splash screen will be displayed asking you to wait a few seconds while the networked 
devices are discovered.The immerGo server window will appear followed shortly afterwards by Apple’s AVB 
Entity Controller window, which is shown below: 
 

 
 
Check that the Entity Controller displays your computer and all of your SPK-4Ps. If this is not the case, follow 
these steps in priority order: 
 

1. Re-check all connectors and switch/SPK-4P activity. 
2. Power down and power up the switch(es). 
3. As a last resort, reboot your computer and restart immerGo. 

 
Select one of the SPK-4Ps and view its input stream (a stream contains multiple audio channels). You should see 
the following: 
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Now select your computer. The SPK-4Ps receive 32 channel streams, and so you need to set your Mac to output 
32 channel streams, as shown below:  
 

 
 
Furthermore, the Mac needs to output its stream in a format that matches the SPK-4P input format. This is 
ensured via the following settings: 
 

 
 

 
 
These settings only need to be made once. 
 
You might receive the following popup – emitted by the inbuilt wav player: 
 

 
 
You can discard this by clicking ‘Don’t Allow’. 
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Now exit the Entity Controller and you should see the following immerGo server user interface, where the 
screenshot below shows the top half of the interface: 
 

 

3.1 WORKING FOLDER: 
 
The ‘Working Folder’ should be a folder that you create and where your localization (.imm) files, multi-channel 
wav files (.wav), scheduler files (.sch) and your speaker configuration file (speakerconfig.xml) will be stored. You 
should create a working folder (giving it a name of your choice), and browse to that folder. 

3.2 CHOOSE AND VIEW WAV FILES: 
 
This option allows you to select multichannel wav files that will be stored on the server and that will be 
accessible on the clients for playback and localization control. You can load the wav files from any folder where 
you might have placed them. You can also view the files that are currently stored. 
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3.3 NUMBER OF SPK-4PS DISCOVERED: 
 
This section indicates how many SPK-4Ps have been discovered by the ImmerGo server. This number should 
match the number displayed by the Entity Controller. 

3.4 MIDI PORT SELECTION 
 
The IAC BUS internal software MIDI link is used to allow the server to communicate with the DAW. Both the 
input and output ports should be set to IAC Driver Bus 1 (see section 4.1.1). The bottom half of the interface is 
shown below: 
 

 
 

3.5 CONNECTION MANAGEMENT 

 Your last interaction with the server is to connect the server to each of your SPK-4Ps. This is done by simply 
clicking the Connect button. When you first start the server, there will probably not be a speaker configuration 
file in the working folder. In this case, you will get the following message: 
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You will then need to click the client button or run the client from a mobile device. You will then be presented 
with a configuration screen. The configuration process is described in section 5 below. 

If there is a configuration file in your working folder, and the configuration file incorporates SPK-4Ps that are in 
your actual configuration, then the connection process will proceed. The connection process causes an audio 
stream to be connected from the Apple Mac server to each of the SPK-4Ps. The connection process takes a few 
seconds, and the number of devices connected should be displayed in the box below the Connect button. Make 
sure that all your SPK-4Ps are connected before you start using the immerGo client. 

 
You can get confirmation of your connections by accessing the Apple AVB Audio Configuration (which should be 
in the dock) and selecting Window -> AVDECC Connection Matrix. You should see that your connections have 
been made (green blocks with crosses as shown below). 
 

 
 

The connection matrix shows all the possible input and output stream connectors on the AVB devices in your 
system. In the connection matrix, an output stream from the Mac is connected (shown by a cross) to the input 
stream connector of each of seven SPK-4Ps. You will not need to make these connections as ImmerGo will make 
the connections for you. The connection matrix will provide confirmation that connections have been made.  
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4 DIGITAL AUDIO WORKSTATION CONFIGURATION 

 
Regardless of the DAW that you are using, you should ensure that you select the Thunderbolt Ethernet interface 
as your audio device. Here is an example of this selection in the Reaper DAW: 

 

As you saw in the previous section, an audio output stream is connected to each of the SPK-4P speakers.  The 
output stream contains 32 audio channels, where the source of the audio channels can be the tracks of a DAW 
or a multichannel wav file. When using a DAW, you can associate each of the tracks with one of the 32 channels. 
This can be done in different ways, depending on your DAW.  

In the Reaper DAW, this would be done by utilizing the connection matrix, as shown below: 

 

 

 

In ProTools, select the Setup menu item, and then select I/O. Click on the Default button, and you should see the 
following crosspoint matrix, where you can assign tracks to AVB stream outputs, as shown below: 
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You should also ensure that in the Mix window, track outputs are assigned to appropriate output channels. In 
the example below successive tracks are assigned to successive output channels (1-8). 
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4.1 MIDI COMMUNICATION BETWEEN IMMERGO SERVER AND DAW 
 
The ImmerGo server communicates with the DAW in order to control its transport. It also receives MIDI Time 
Code from the DAW, which it uses to time stamp 3D coordinates it receives from the mobile client(s), and which 
it also forwards to the mobile client(s) for display purposes. To enable this, the DAW must be set up to receive 
messages on the same MIDI link as used by the server (internal driver), to respond to particular MIDI transport 
control messages, and to transmit appropriate MIDI Time Code messages. Note – you can use ImmerGo to only 
spatialise multichannel wav files. In this case, you would not need to configure ImmerGo for MIDI 
communication. 

4.1.1 MIDI internal driver 
 
The DAW should be set up such that it reads MIDI from IAC BUS driver 1 and transmits MIDI on IAC BUS driver 1. 
To do this, you should run ‘Audio MIDI Setup’ then select ‘Show MIDI Studio’ from the Window menu. You 
should see the screen below: 
 

 
 
Double click the IAC driver icon and check the ‘Device is online’ box. 

4.1.2 MIDI and transport control 
 
The DAW on the server needs to be configured in such a way that it will receive MIDI transport commands and 
respond appropriately. Here are the MIDI messages and the transport controls that they are associated with: 
 

Transport control MIDI Message - hexadecimal followed by ( CC decimal) 
Play B0   75 7F (CC 117) 
Stop B0   74 7F (CC 116) 
Pause B0   70 7F (CC 112) 
Fast Forward B0   73 7F (CC 115) 
Rewind B0   72 7F (CC 114) 
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4.1.3 MIDI Time Code 
 
The DAW needs to be configured such that it generates MIDI Time Code. By default the frame rate for the 
timecode is 30 frames/second. 

4.2 MIDI CONFIGURATION WHEN USING THE REAPER DAW: 
 
To Set up MIDI correctly in Reaper, from the Menu bar: 
 
Select Reaper -> Preferences -> from the Audio drop down, select MIDI devices. Then enable IAC Driver – Bus 1 
as the MIDI input and MIDI output driver as shown below: 
 

 
 
You will have received a zip file called ReaperFiles. When you unzip this, you will find : 
 

1. SkalandunasDistr.zip – this contains a multitrack Reaper project with a MIDI Time Code generator in the 
first track and also the MIDI transport control appropriately configured. (Acknowledgements to Mike 
Skalandunas for this multitrack). 

2. Transport.ReaperKeyMap – this is a file that should be imported into your Reaper project if you do not 
use the above Skalandunas template file. It contains the MIDI transport control commands. This 
importing can be done in the following way: 

 
Go to: Actions -> Show Action List -> click import/export button -> select Import -> browse to the file 
Transport.ReaperKeyMap and click Open.  This will enable the appropriate MIDI transport commands to be 
received by Reaper for control of the DAW. However, you will need to create a MIDI Time Code track for the 
transmission of MIDI Time Code. Refer to the Reaper user guide for this. If you use the Skalandunas project, then 
this is already created for you, and you could use this project as a template for others. 
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4.3 MIDI CONFIGURATION WHEN USING THE PROTOOLS DAW 
 
To set up MIDI correctly, select Setup -> MIDI -> MIDI Input Devices. You should see the following: 

 

In order for ProTools to receive MIDI transport commands from ImmerGo, you need to choose: 

Setup -> Peripherals -> MIDI Controllers, upon which you will see the following table: 

 

Ensure that you set up the table accordingly. ProTools needs to be configured to transmit MIDI Time Code 
messages to the ImmerGo server to synchronize playback of localization moves with the audio. To enable this, 
you should select: Setup -> Peripherals -> Synchronization, upon which you should set the MTC Generator port 
as shown below: 

 

 

Make sure that the GEN MTC button in the Transport window is selected. The time code frame rate can be set 
up via: Setup -> Session, and selecting the frame rate within the session window.  
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5 SPEAKER CONFIGURATION 
 
immerGo needs to know the positions of the speakers in your room in order to correctly localize the audio tracks 
that you select and move. When localizing sounds, immerGo refers to a file named speakerconfig.xml that 
resides in your working folder. This section describes a graphical configuration capability within immerGo that 
allows you to place the speakers within a graphic representation of your room. After positioning your speakers, 
you can save the configuration and this will cause immerGo to create the speakerconfig.xml file in your working 
folder. As in the case of localization of sound sources, you can perform graphical speaker configuration within a 
client that resides on the server or on a remote mobile device. 

5.1 STARTING THE CONFIGURATION 

When you start the immerGo server for the first time, you will have one of the following two situations: 

1. There will be no speakerconfig.xml in the working folder 

2. There will be a speakerconfig.xml in the working folder, but it will not be aligned with your SPK-4s. 

In either case, the server will indicate that you need to start a client to configure your speakers. 

Similarly, when you start up a client, you will be told that there is no speaker configuration file, and asked to 
continue with the configuration process. On continuing with the configuration process, you will be presented 
with a representation of a room, and a series of configuration control buttons, as shown below. 
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5.2 CONSTRUCTING A CONFIGURATION 
 
Before you start adding speakers to your configuration, you should first: 
 

• Measure the dimensions of your room: 
o Length – the distance from the center of the front-most speaker, to the center of the speaker 

that is furthest back in the room.  
o Width - the distance from the center of the left-most speaker, to the center of the speaker that 

is furthest to the right of the room.  
o Height – the distance from the center of the bottom-most speaker, to the center of the speaker 

that is highest in the room.  
• Enter the dimensions of the room (cms) – type in the length (l), the width (w) and height (h), then click 

‘submit’ or type <enter> after your last entry. 
 
The top row of buttons corresponds to all the possible speakers in your configuration. For example, if you have 4 
x SPK-4Ps, then there will be 8 speaker buttons (each SPK-4P can have a further speaker attached to it). If you 
have 8 x SPK-4Ps, then there will be 16 speaker buttons. immerGo uses sound (a short ‘Beep’) to help you 
associate a speaker button with a particular speaker in your actual configuration. To enable this capability, you 
need to make sure that the default sound output for your Mac is the ThunderBolt Ethernet interface. To do this: 
 

1. Select your Apple ‘System Preferences’ 
2. Select Sound 
3. Select ‘Output’ 
4. Choose the ‘your Mac name’:Thunderbolt Ethernet interface. 

 
An example is shown below: 
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To add a speaker to your configuration, you should do the following: 
 

1. Select a speaker button – it will highlight as the selected speaker. 
2. Select the ‘Beep’ button – if you hear a speaker beep, you know that the speaker is indeed part of your 

configuration, and you can locate it. 
3. Select the ‘Add’ button – this will cause the speaker to appear in the middle of the room, as shown 

below. 
 

 
 

4. Drag the speaker to a position that represents its actual position in the room. You can use the slider to 
adjust the speaker height (the white rectangle indicates the height of the speaker). If you are using a 
mobile device, you can select the up/down check box and adjust the height of the speaker by tilting the 
mobile device.  

5. As you re-position the speaker, the x, y and z coordinate values (in cms) will change. The coordinates are 
relative to the bottom left front of the room.  

6. If you select a speaker, select ‘Beep”, and there is no sound, it could be that there is not an actual 
speaker associated with that speaker button. In this case, you could select the ‘disable’ button. This will 
give the selected speaker button a purple outline, and it will afterwards not be selectable. Selecting the 
‘Enable’ button’ will re-enable all disabled speaker buttons. 

7. If none of the speaker buttons respond to a ‘Beep’ request upon selection, then there is probably a 
problem with your AVB network configuration. Go back to section 3.1, and check that you have fulfilled 
the requirements. In particular check that there are connections in the AVB connection matrix.  



    
 

ImmersiveDSP Ltd., / www.immersivedsp.com / Features and specifications subject to change without prior notice 21 

8. Bass speakers – you can add one or more bass speakers to your configuration by doing the following: 
a. Select a speaker 
b. Select the ‘Bass’ button – the ‘Spkr’ text on the button will be replaced by ‘Bass’. 
c. Beep the speaker to determine its location 
d. Move the bass speaker to its allocated location in the room 

Note that if a speaker is designated as a bass speaker, immerGo will direct all non-muted tracks to that 
speaker. 

 
Following this configuration process, you may have a room configuration that appears as shown below: 
 

 
 
To save this configuration, select the ‘Save’ button. This will save your configuration in the speakerconfig.xml file 
in your working folder. You can now immediately start localization control by selecting the ‘Controls, button. The 
immerGo client interface might appear as follows: 
 
 
 



    
 

ImmersiveDSP Ltd., / www.immersivedsp.com / Features and specifications subject to change without prior notice 22 

 

 
 
As you can see, the speaker positions in the localization page correspond to the positions that you set up in the 
configuration page. Note that while displaying the speakers in the localization page, immerGo re-computes the 
room length and room width, such that the room border fits more exactly around the speakers.  
 
You can view the contents of the speakerconfig.xml, and indeed you can edit the coordinates that are within the 
file or even create a whole new set of coordinates. Remember that the units are centimeters, and the 3D 
coordinates are measured relative to the bottom front left of the room. 
 
Given below is a listing for the speakerconfig.xml that corresponds to the above configuration. 
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The ‘amplifier’ entity refers to an SPK-4P, which has a unique Ethernet address. Each ‘speaker’ entity, associated 
with the SPK-4P, has a speaker number, x, y, and z centimeter coordinate values, a type which could be ‘normal’ 
or ‘bass’, and an indication of whether the speaker is used or not. The ‘used’ attribute is used to take account of 
a situation where not all of the secondary speakers on the SPK-4Ps are actually connected. 
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6 THE MOBILE CLIENT 

 
You can control ImmerGo from the client interface on your workstation, or you can run the ImmerGo client on 
your mobile device. You can access the ImmerGo client on an Android device via the Play Store and also on an 
iOS device via the Apple store. Alternatively, the server page provides you with a URL that you can type into your 
mobile device browser. This will be something like the following:  
 
‘http://192.168.0.104:8000/ImmerGoClient.hml’ 
 
but will vary depending on the IP address of your server. The server user interface indicates your particular URL. 
Regardless of how you load the client, you should be presented with a graphical user interface. Given below is a 
graphical user interface with annotations: 

 

 

1 
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6.1 A GUIDE TO THE IMMERGO CLIENT USER INTERFACE 
 
This interface will vary, depending on the configuration of speakers in your SpeakerConfig.xml file. 
 
The top half of the user interface is a representation of the room that contains your speakers. The view is from 
the top of the room.  The bottom half of the user interface comprises a number of buttons, sliders and 
checkboxes that all enable control over the recording and play back of multitrack immersive sound. 
 
This short guide will describe each of the labelled items in the representation of the user interface shown above. 
 

1. The representation of the virtual source that a user can move in the horizontal plane. The sound that 
will be localized derives from the currently selected track. 
 

2. A check box that, when ticked, enables the vertical control over the virtual source. As you tilt the mobile 
device upwards and downwards, so the virtual source position will rise and fall.  

 
3. This white rectangle indicates the vertical position of the virtual source. If the Up/Down check box is 

ticked, then the rectangle will move as the mobile device is tilted up and down. 
 

4. This slider responds to mobile device orientation, in particular up/down tilts. If ImmerGo is run on a 
desk top or laptop, then this right vertical slider can also be used to control the vertical position of the 
virtual sound source, and thus the position of the white rectangle.  

 
5. A representation for a speaker that is installed in the ceiling (top of the room). 

 
6. The Track selection buttons. They allow you to select a particular source within a DAW that will be 

moved within a 3D space. The tracks correspond to outputs from a DAW, and also to Ethernet AVB 
stream channels. With the SPK-4 ImmerGo system, there are a maximum of 32 stream channels, and 
thus a maximum of 32 tracks that can be localized. A DAW will typically allow you to mix multiple DAW 
tracks onto a single channel. The ‘<<<’ and ‘>>>’ buttons allow you to display further tracks, either 
higher or lower numbered. 

 
7. DAW transport control buttons. These buttons allow you to control the transport of the server side DAW 

from your mobile device. There is also a timecode display that will change while your DAW soundtrack 
plays. 

 
8. Miscellaneous buttons: 

 
a. Mute/Solo – allow you to mute or solo the selected track. The Track buttons will be highlighted 

appropriately to indicate muting. To un-mute a muted track, select the track and tap the Mute 
button. Similarly, to un-solo a solo’ed track, select the track and tap the Solo button. 

b. Record – in order to record your localization moves, you should: 
i. Select a track 
ii. Tap the Record button 

iii. Tap the Play button 
iv. Move the virtual source circle and/or the white rectangle 
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v. Tap Stop when complete 
c. Display – if you select a track and tap this button, then a small track circle will indicate the 

location of the virtual source for that track when your stored localizations are played back. You 
can display more than one virtual source. 

d. Save/Load – will allow you to save your time stamped localizations and load them back at a later 
time. Note, you can record over any track’s localizations at any point within the time line of your 
saved localizations. Simply choose a track, record, then stop when complete. 
 

9. Spread – this slider controls how ‘wide’ the sound source seems. 
 

10. Track Volume – allows for the control of the volume of the selected track. 
 

11. Bass – This button is relevant if you have one or more sub-woofers in your speaker configuration. Then if 
this button is selected, the track volume control slider will control the volume of the sub-woofers. 
 

12. Master Volume – As its name implies, this slider will control the volume of all tracks and thus raise or 
lower the volume of the entire multitrack being played back by the DAW. 
 

13. Settings – This button is used to take you to a ‘Settings’ screen where you can modify various immerGo 
settings. Currently the only available is a ‘Names’ settings, allowing you to modify the names of the 
tracks. This capability will be described in the following section. 
 

14. Config – On clicking will take you to the speaker configuration window, where you will be able to 
reconfigure your speaker configuration, as long as there are no other clients currently active. 
 

15. WavCtrl – This will tke you to the multichannel wav player window, where you can select channels and 
localize them, much as you do in the DAWCtrl window. 
 

16. AmbCtrl – This will take you to the Ambisonics control page. Refer to section 5.6. 
 

6.2 SETTING THE NAMES OF TRACKS 

When you first load the immerGo client, the track buttons are labelled Track1, Track2, etc. The track naming 
capability allows you to provide meaningful names for each of the tracks. This makes it easier to choose a 
particular track for localization.  

In order to access this capability, you need to select the ‘Settings’ button. This will take you to a new display, 
where you can: 

1. Select a track to re-name 

2. Select the ‘Name’ button 

3. Type in the new name of the track 

 

This is shown in the screenshot below: 
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You can return to the 
localization control screen by 

clicking the ‘Controls’ button. 

6.3 CREATING A NEW MULTITRACK LOCALIZATION FILE 
 
If you have started the ImmerGo server, and have not loaded a localization file, then you can start recording new 
position changes for up to 8 tracks. First, you must start a DAW such as Reaper, and ensure that the DAW is 
properly configured. Refer to the DAW configuration section above. Now to record source position changes for a 
single track you should: 
 
1. Select a track by tapping a track button (Track1 …Track32) 
 
2. Tap the ‘Play’ button and listen to the track’s movement as you move the virtual track circle and tilt/swivel 

your mobile device. This should give you a sense of the nature of the source position changes that you 
would like to make during the playback of the multitrack soundtrack.  

 
3. You should see the timecode display change as the soundtrack plays. If you would like to hear only the track 

whose positions you are recording, then ‘Solo’ the track by tapping the ‘Solo’ button. 
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Note: A typical approach to ImmerGo localization control is to position the sound source horizontally by 
moving the sound source circle, and at the same time position it vertically by tilting the mobile device up 
and down (after checking the up/down check box). In this way the position of the sound source circle as well 
as the position of the height rectangle give you a good visual sense of the sound source position.  

 
4. Now tap the ‘Record’ button and then the ‘Play’ button. As you move the virtual sound source circle and/or 

change the orientation, the server will record the 3D position of the chosen track’s sound, as well as the 
current time. 

 

 
 
 
5. Tap the ‘Stop’ button when you have finished localizing the track. 
 
6. You can now localize a different track. To do this, first select the new track and if you want to only hear this 

track while you localize, then tap the Solo button. If you want to hear the previously recorded track as well 
as the new one, then select the previously recorded track and tap the Mute button to unmute the track. 

 
7. While localizing a new track, you can visualize the movements of other tracks, by using the ImmerGo 

‘Display’ feature. Select the track you want to visualize, and tap the Display button.  
 
8. At any point, you can save your localization recording to disk. Tap the ‘Save’ button and type in the name of 

your file in the dialog box that pops up. Your file will be saved, with the ‘.imm’ extension, in your working 
folder. 

 
Note: It is possible to record over any localization for any track at any point in the multitrack recording. You 
could for example: 
 

a. Pause playback at a point where you would like to change the localization for a track. Then you can 
select the track, tap record, tap play and proceed to change the localization. 

b. While you are playing a multitrack with its localizations, you could select a track, tap record and proceed 
to change the localization. 

 
For both the above cases, tap Stop to end the localization change. 

Note:  If at any point you are not able to control the transport of your DAW from your client device, make sure 
that the AVB interface is selected in your DAW. It may be necessary to re-select even if the interface was 
previously selected. In Reaper this is done by selecting  Options -> Preferences -> Device. 
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6.4 MULTI-CHANNEL WAV FILE LOCALIZATION 

immerGo allows you to load multichannel wav files and to localize the channels of these wav files. You would 
first need to load your multichannel wav files from the immerGo server, as described in section 4.2. Then, on the 
client (mobile or workstation), you select the WavCtrl button. This will take you to the multichannel wav player 
window as shown below.  

 

The controls are very similar to those for DAW control, with a few exceptions: 

1. There is a button, which when selected allows you to load a wav file for localization. 

2. There is an indication of the current wav file 

3. There is a button, which when clicked displays the Scheduler page 

There is no pause button, you are only able to stop wav playback. This is because immerGo can only make 
use of the controls available on the workstation’s multichannel wav player. 

When using this wav playback capability, be sure that your default sound output device is the Thunderbolt 
Ethernet interface (see section 5.2).   

 

2       
1       

3       
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6.5 THE SCHEDULER 

immerGo has a Scheduler capability that allows a user to specify a sequence of multichannel wav files to be 
played back. It can be accessed by clicking the ‘Scheduler’ button of the wav control page. The first Scheduler 
page is shown below: 

 

By clicking the ‘Add’ button, you add a new scheduled entry row to the Scheduler table. A Scheduler table with 
row entries is shown below: 

 

Within the row, there are two drop-down lists that allow you to select: 
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1. The wav file to be played 

2. The imm (localization) file that will localize the multiple channels of the wav file 

Furthermore, there is: 

3. An edit box that allows for the entry of a loop count, i.e. the number of times the wav file should be 
played.  

4. A radio button indicates which row entry should be scheduled first.  

A ‘Clear’ button causes the whole table to be cleared. A ‘Play’ button starts playback of the schedule, and a 
‘Stop’ button stops it. A ‘LoopOn’ button causes the entire schedule to be played over and over again until the 
button is pressed again, or the ‘Stop’ button is pressed.  

A schedule can be saved by clicking the ‘Save’ button and typing a name for the schedule. A schedule can be 
accessed by clicking the ‘Load’ button and selecting from a list of schedule names. 

6.6 AMBISONICS 
 
One of the powerful features of ImmerGo is that it allows you to localize particular sound tracks on top of a 
decoded Ambisonic sound field. So for example, you might want to have a particular sound environment, be it a 
city centre or nature scene, and to have sounds - voices or instruments, moving within the environment. This 
can be achieved by assigning ambisonic tracks to the last of the 32 available tracks – ‘x to 32’, where x depends 
on the ambisonic order, 29 in the case of 1st order ambisonics, 24 in the case of 2nd order ambsonics. In the 
context of an AVB network of SPK-4Ps and NDAC-2s, these devices will decode channels ‘x to 32’, and thereby 
create the environment above which point sources from channels ‘1 to x’ can be located. 

The channel layouts for each order of Ambisonics up to 4th order is given below:  

1. 1st order: ch29 – 32 
2. 2nd order: ch24 – 32 
3. 3rd order: ch17 – 32 
4. 4th order: ch8 – 32 

 
The ambisonic controls will appear when the AmbiCtrl button is clicked, as shown in the following labelled user 
interface: 
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Given below is a short description of each labelled item: 

1. Choose between two normalization schemes – Schmidt semi-normalized (SN3D) or fully-normalized 
N3D. 

2. The ambisonic order can be selected from a drop-down – 1st order (1) to 4th order (4). The appropriate 
ambisonic decoder will be used in the speakers. 

3. Mute and Solo buttons to either discard ambisonics (mute) or only have ambisonic tracks playing (Solo). 

Sliders: 

4. Yaw – Z axis rotation, horizontal rotation of the sound field. 

5. Pitch – Y axis rotation, sometimes known as ‘tumble’ , soundfield rotates around the left/right axis. 

1 2 3 

7 

5 

8 

6 4 

1 

9 

10 
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6. Roll – X axis rotation, sometimes known as ‘tilt’, soundfield rotates around the front/back axis. 

7. Volume – slider controls volume of ambisonic tracks 

8. Vertical offset – slider controls height of soundfield 

9. Bass Volume – slider controls bass level of ambisonic tracks 

10. Ambisonic tracks – these are highlighted in red, while the point source tracks keep their naming. 
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7 APPENDIX 1 – LUMINEX CONFIGURATION 

 

In order to allow your Luminex switch to operate in an ImmerGo system, these are the steps that you should 
follow: 

1. Go to the Luminex switch web console. To do this, open a web browser and type the appropriate IP 
address for the switch configuration, usually 192.168.46.57 

2. Navigate to “Groups” 

3. Select the “Management” group 

4. Select “Advanced” 

5. Ensure that AVB is enabled and ensure that “Legacy SET 1” is enabled, as shown below 
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8 APPENDIX 2 – ALERTS AND THEIR RESOLUTION 
 
This appendix describes alerts that might pop up, indicating issues with the running of ImmerGo. The points 
below describe these pop-ups and how to resolve them. 
 

1. “To control a DAW, load/enable a MIDI driver - see manual” 
This indicates that the IAC internal MIDI driver is not enabled. Refer to section 4.1.1 

 
2. “Please ensure your computer is plugged into an AVB Network and start the application again” 

Make sure that your Mac is connected to a Thunderbolt to Ethernet connector, and that this connector 
is connected via an Ethernet cable to an Ethernet AVB switch, such as a Presonus, Luminex or Extreme 
switch. 

 
3. “There was an error opening avbutils” 

In order to utilize the AVB features, ImmerGo makes use of Apple’s avbutil utility. The avbutil utility 
allows ImmerGo to get information about all the AVB devices on your network, and also to connect 
them together via a connection matrix. If this message appears, it might mean that ImmerGo was 
unsuccessful in initializing this capability. In this case, try the following: 
First run the Terminal Mac application to get a terminal window going on your Mac. You should then use 
the following commands from the terminal prompt: 

a. ‘networksetup –listallhardwareports’ to determine the name of your Ethernet device (interface-
name). This will be a name such as en0, en1, en3, …, and is known as the ‘interface name’. 

b. ‘avbutil –-virtual-audio enable <interface-name>’ – to enable the virtual audio entity on your 
Ethernet interface. This virtual entity is the source of audio streams from your Mac. 

c. ‘avbutil –-controller to enable and launch the AVDECC controller. AVDECC stands for ‘Audio Video 
Discovery, Enumeration, Command and Control’. It is the AVB control protocol. 

 
4. “There was an error finding network devices” 

ImmerGo utilizes a capabaility known as PCAP to transmit control and connection management 
messages on the AVB network. Typically Apple Mac computers incorporate this capability. However, it 
has been found that some Mac Airs do not. The easiest way to resolve this is by installing WireShark, a 
free packet analyzer tool. As part of its installation, it adds the PCAP capability. On installation, it will 
also give you the option of installing ChmodBPF. Make sure that you perform this installation as well. 
You can download and install WireShark from: 

https://www.wireshark.org/download.html 

5. “Must have 3 or more SPK4Ps in configuration” 
Ensure that you have at least three SPK-4Ps or NDAC-2s on the AVB network 

 
6. “No config file, start Client to configure” 

This message will appear if you don’t have a working folder with a speaker configuration file. You will be 
able to create a speaker configuration file from a client, regardless of whether the client is on your 
workstation or on a mobile device. 

 


